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1. Установка среды Keil 

Скачать MDK Keil 5 можно с официального сайта. (Процесс установки Keil 4 отличается 

не значительно) 

После запуска исполняемого файла, появится окно приветствия установки. Необходимо 

нажать кнопку «Next» 

 
Рисунок 1.1 

Содержание следующего окна является лицензионным соглашением.  

Необходимо установить галочку, которая подтверждает согласие с содержимым 

лицензионного соглашения, и нажать кнопку «Next» 

 
Рисунок 1.2 
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В следующем окне необходимо произвести выбор папки для установки среды Keil и 

расположение папки PACK. (PACK используется в среде Keil версии 5 и выше. Более 

подробно о данном инструменте будет далее.) И нажать кнопку «Next» 

 
Рисунок 1.3 

В данном окне необходимо указать личные данные и нажать кнопку «Next» 

 
Рисунок 1.4 

Начнется установка среды Keil. 
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Рисунок 1.5 

Когда прогресс статус-бара дойдет до конца, установка завершится. 

Появится следующее окно: 

 
Рисунок 1.6 

Наличие галочки в пункте «Show Release Notes» означает, что после нажатия кнопки 

«Finish» откроется текстовый файл с описанием изменений в релизах среды Keil.  

Установка завершена.  
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2. Интеграция NIIIS в среду Keil (только для Keil 5) 

Необходимо добавить поддержку семейства МК в среду Keil, для этого откроем файл 

..\UV4\PACK.xsd в текстовом редакторе 

В блоке <!-- Registered Device Vendors --> 

Добавить строчку  

<xs:enumeration value=”NIIIS:200”/> 

 
Рисунок 2.1 

Необходимо сохранить редактируемый файл, и запустить среду Keil 
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Рисунок 2.2 

 
Рисунок 2.3 
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3. Установка Pack 

Необходимо открыть среду Keil 

Нажать на иконку «Pack installer» 

 
Рисунок 3.1.1 

Появится окно приветствия Keil Pack Installer 

 
Рисунок 3.1.2 

Можно убрать галочку «Show this dialog at startup» 

Необходимо нажать кнопку «ОК» 
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Выбрать File->Import…   

 
Рисунок 3.1.3 

Выбрать файл Keil.1914BМ014.pack и нажать кнопку «открыть» 

В списке устройств появится МК 1914ВМ014 в разделе NIIIS 

 
Рисунок 3.1.4 



10 

 

4. Основные средства Keil  

 
Рисунок 4.1 

Главное окно проекта в среде Keil содержит несколько внутренних окон: 

Сверху содержатся иконки быстрого доступа (они дублируют пункты меню) 

Слева расположено многофункциональное окно с вкладками: Project (файлы проекта), 

Book (документация и описания), Functions (функции, которые содержатся в проекте) и 

Templates (средства программирования).  

Внизу вывод информационных сообщений линковщика и компилятора. 

Основное окно – окно редактора (в данном примере файл main.c) 
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5. Настройка среды Keil. Создание первой программы. 

Необходимо создать новый проект. 

 
Рисунок 5.1.1 

Выбрать папку для сохранения проекта 

 
Рисунок 5.1.2 

Выбрать микроконтроллер 1914BM014 
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Рисунок 5.1.3 

Необходимо выбрать, какие библиотеки подключить. Startup подключается для любого 

проекта. В данном примере мы будем использовать библиотеку GPIO. 

 
Рисунок 5.1.4 
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После нажатия кнопки «ОК» появится окно проекта 

 
Рисунок 5.1.5 

Необходимо добавить файл main.c, для этого нажать на Source Group 1 правой клавишей 

мыши и выбрать Add New Item. В появившемся окне выбрать C File (.c) и ввести название 

«main» 

 
Рисунок 5.1.6 

 

В папке Source Group 1 появился файл main.с  

Необходимо кликнуть на него дважды, справа откроется окно редактора. 
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Необходимо подключить Device header и драйвер GPIO. Для этого правой клавишей 

мыши кликнуть в пустом месте открытого файла main.c, перейти в раздел “Insert #include 

file” и выбрать сначала 1914BM014.h, а затем 1914BM014_gpio.h 

 
Рисунок 5.1.7 

Основное тело программы  

int main(void){ 
 
} 

 

 

В него добавим настройку порта GPIOA и управление первым пином в бесконечном цикле 

while(1){ 
 
} 
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Рисунок 5.1.8 

Текст программы на рисунке 5.1.8: 

#include "1914BM014.h"                  // Device header 
#include "1914BM014_gpio.h"             // Keil::Drivers:GPIO 
 
int main(void){ 
  GPIO_InitTypeDef GPIO_InitStructure; 
  GPIO_InitStructure.GPIO_Pin = GPIO_Pin_14; 
  GPIO_InitStructure.GPIO_Mode = GPIO_Mode_OUT; 
  GPIO_Init(GPIOA, &GPIO_InitStructure); 
 
  while(1){ 
    GPIO_SetBits(GPIOA, GPIO_Pin_14); 
    for(int i=0;i<100000;i++){}; 
    GPIO_ResetBits(GPIOA, GPIO_Pin_14); 
    for(int i=0;i<100000;i++){}; 
  } 
} 

 

Далее необходимо скомпилировать проект (иконка «Rebuild») 
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Рисунок 5.1.9 

Последняя строчка в программе должна быть пустой. Если это не так, keil выведет 

сообщение “warning” в окне “Build Output” 
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6. Загрузка программы в ОЗУ 

В загрузчике микроконтроллера не предусмотрен запуск программы из ОЗУ после сброса. 

Для реализации отладки в ОЗУ необходимо добавить инициализацию в Debug режим. 

(Открыть настройки Target. Нажать сочетание клавиш Alt+F7 или Project->Options for 

Target) 

 
Рисунок 6.1 

Это делается путем создания ram.ini файла следующего содержания: 

(*((volatile unsigned long  *)(0x4001E008))) |= 0x1; 
FUNC void Setup (unsigned int region) { 

region &= 0xFFFFF000; 
SP = _RDWORD(region); // Setup Stack Pointer 
PC = _RDWORD(region + 4); // Setup Program Counter 
_WDWORD(0xE000ED08, region); // Setup Vector Table Offset Register 

} 
Setup(0x8000000); // Get ready to execute image in SRAM or whatever region it is in G,main  

Этот файл будет автоматически исполняться микроконтроллером перед запуском средства 

отладки. 

На той же вкладке необходимо зайти в настройки адаптера, в данном примере это «J-

LINK/J-TRACE Cortex».  

При первом входе в данные настройки, может появиться сообщение 
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Рисунок 6.2 

Необходимо нажать кнопку «ОК». Откроется меню выбора устройства и ядра: 

 
Рисунок 6.3 
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С помощью фильтра выбрать ядро «Cortex-M4»  

 
Рисунок 6.4 

Необходимо выбрать первую строку «Unspecified / Cortex-M4 / Cortex-M4 / 1 / - / - » и 

нажать кнопку «ОК» 

Далее необходимо выбрать порт загрузки (Поддерживаются режимы JTAG и SW. 

Переключение между портами производится с помощью перемычек на плате). Во всех 

примерах далее используется SW. 

 
Рисунок 6.5 
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В данном окне выбрать вкладку Flash Download и выставить настройки согласно рисунку 

6.6: 

 
Рисунок 6.6 

 

Далее необходимо настроить адресацию для линковщика. 

Согласно п 5.2 технического описания: PROG SRAM расположена по адресу 0x08000000 

и имеет размер 256кб, а SRAM по адресу 0x20000000, её размер 64кб. (за исключением 

части оперативной памяти, отведенной под хранение конфигурационных данных 

контроллера ПДП) 

В настройках проекта необходимо указать адресацию, но регистры ПДП в библиотеках 

расположены в конце ОЗУ и занимают 1024 байта. Их нужно исключить из обработки 

линковщика. 

IROM 0x8000000, размер 0x40000. IRAM 0x20000000, размер 0xFBF0 (0x10000 – 0x410 на 

ПДП) 

А также указать частоту работу микроконтроллера.  
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Рисунок 6.7 

Необходимо нажать ОК и скомпилировать программу (Rebuild) 

В окне Build Output не должно возникать ошибок. 

Следующим шагом необходимо запустить Debug->Start или использовать сочетание 

клавиш «Ctrl + F5» 

 
Рисунок 6.8 
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Теперь необходимо запустить программу (Run), нажав соответствующую иконку или 

клавишу F5. 
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7. Загрузка программы во внешнее ПЗУ  

7.1 Загрузчик 

Загрузчик микроконтроллера имеет несколько режимов работы (см. п.7 технического 

описания) с памятью на внешней шине данных. 

Помимо перечисленных режимов работы есть еще режим REMAP (п. 7.1.2 технического 

описания).  

Для наглядного восприятия, представим режимы работы внутреннего загрузчика (таблица 

7.1 технического описания) в следующем виде: 

 Шина в 32-битном режиме Шина в 8-битном режиме 

Непосредственное 

выполнение программы из 

внешней памяти 

PE[15:13] = 000 
Микроконтроллер 

конфигурирует внешнюю 

шину на работу в 32-битном 

режиме со значением 

WAIT_STATES = 4 и 

начинает выполнять 

программу из внешней 

памяти. 

PE[15:13] = 100 
Микроконтроллер 

конфигурирует внешнюю 

шина на работу в 8-битном 

режиме со значением 

WAIT_STATES = 4 и 

начинает выполнять 

программу из внешней 

памяти. 

Загрузка памяти из внешней 

шины 
PE[15:13] = 010 
Микроконтроллер 

конфигурирует внешнюю 

шину на работу в 32-битном 

режиме со значением 

WAIT_STATES = 4, 

копирует пользовательскую 

программу из внешней 

памяти во внутреннее ОЗУ и 

передаёт ей управление. 

PE[15:13] = 001 
Микроконтроллер 

конфигурирует внешнюю 

шину на работу в 8-битном 

режиме со значением 

WAIT_STATES = 4, 

копирует пользовательскую 

программу из внешней 

памяти во внутреннее ОЗУ и 

передаёт ей управление. 

Таблица 7.1.1 

Среда Keil позволяет работать с памятью на внешней системной шине, используя ОЗУ 

подключенного микроконтроллера (см Рисунок 6.6, RAM for Algorithm). 

В данную область памяти загружается программа, содержащая алгоритм. В примерах 

использовалась память AM29LV400B в 8-битном режиме, две микросхемы памяти 

AM29LV160D в 16 битных режимах для организации 32 битной памяти, а также СОЗУ 

1658py2t. 

Алгоритмом для работы с памятью является файл *.FLM,  который находится в папке 

../FLASH 

7.2 Режим работы шины. 

Встроенный загрузчик позволяет работать с внешней системной шиной только в 2-х 

режимах: 8-битном и 32-битном. Перед началом загрузки выбранным алгоритмом, 

необходимо переконфигурировать внешнюю системную шину в нужный режим. Для 
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этого в настройках Target (Открыть настройки Target. Нажать сочетание клавиш Alt+F7 

или Project -> Options for Target) выбрать вкладку Utilities. 

 
Рисунок 7.2.1 

Настроим конфигурацию внешней системной шины перед исполнением алгоритма 

загрузки в микросхему памяти путем создания flash.ini файла следующего содержания: 

(*((volatile unsigned long  *)(0x40013008))) = 0x0; 
(*((volatile unsigned long  *)(0x40013000))) = 0xFFFFFF02;  
Для конфигурации в 32-битном режиме или 

(*((volatile unsigned long  *)(0x40013008))) = 0x1; 
(*((volatile unsigned long  *)(0x40013000))) = 0xFFFFFF02;  
Для конфигурации в 8-битном режиме. 

По адресу 0x40013008 располагается регистр EBC->LOW8 (таблица 16.9 технического 

описания), с помощью которого происходит конфигурация режимов работы для 

соответствующих регионов памяти. 

По адресу 0x40013000 располагается регистр EBC->CONTROL (таблица 16.6 

технического описания), с помощью которого происходит управление внешней системной 

шиной. В данном регистре нас интересует длительность фаз обращения для региона 

памяти (таблица 16.2 технического описания). В примерах используется максимальная 

длительность фаз обращений.  

Примечание. При работе с внешней микросхемой памяти, важно учитывать скорость ее 

работы и длину соединительных линий.  

Например, используемая в примерах память S29AL016D70 (2 микросхемы в 16 битных 

режимах подключены на разные линии данных: на 16 младших и 16 старших бит данных). 



25 

 

Стандартная длительность фаз (после работы загрузчика) для любого региона выборки 

0x4 (расшифровку см. в таблице). При конфигурации PLL выше 48мгц, микроконтроллер 

начинает считывать данные с ошибками. Корректировка выборки до 0x5 позволяет 

стабильно работать до 60мгц включительно. 

 7.3 Способ исполнения программы 

7.3.1 Непосредственное исполнение программы из внешней шины. 

Необходимо настроить линковщик на адрес внешней памяти, в данном случае, это 

0x10000000 и указать её размер. 

Настройка линковщика для S29AL016D70 (2x16мбит): 

 
Рисунок 7.3.1.1 
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Далее во вкладке Debug необходимо настроить адаптер (J-LINK) 

 
Рисунок 7.3.1.3 

В разделе Download Function нами использованы настройки, приведенные на рисунке 

7.3.1.3 

После нажатия кнопки «Add», появится окно выбора алгоритмов программирования 

памяти.  

 
Рисунок 7.3.1.4 

В качестве примера выберем AM29LV160DB32 (2 микросхемы памяти), как показано на 

рисунке 7.3.1.5. Стартовый адрес такой, как и в линковщике, 0x10000000, размер 0x400000 
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Рисунок 7.3.1.5 

Осталось загрузить программу. Для этого можно нажать клавишу F8 или в меню Flash-

>Download. 
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 7.3.2 Копирование программы из внешней шины в ОЗУ и передача 

управления. 

Данный режим работы подробно описан в п.7.1 технического описания. 

Для удобной работы, в PACK содержатся алгоритмы для программирования микросхемы 

памяти в данный режим. 

Программа из внешней памяти перекачивается в ОЗУ по адресу 0x8000000 с передачей 

управления, значит, линковщик должен быть настроен на данный адрес. 

 
Рисунок 7.3.2.1 

Размер программы 256 кб-8 байт (размер программы + адрес, см техническое описание), 

что составляет 0x3FFF8. 

В настройках адаптера во вкладке Flash Download выбираем алгоритм с пометкой «toRAM 

from Flash» 

Стартовый адрес, как в линковщике 0x8000000, адрес 0x3FFF8. См. рисунок 7.3.2.2 
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Рисунок 7.3.2.2 

Примечание: физически микросхема памяти находится по адресу 0x10000000, но в 

алгоритме программирования адрес программирования подменяется с 0x8000000 на 

0x10000008. В первые 8 байт пишется служебная информация. Потому функция «Verify» 

работать сразу после прошивки не будет, т.к. она проверяет наличие программы по адресу 

0x8000000, а не по 0x10000008. Но после того, как программа была перекачана в ОЗУ, 

можно проверить целостность программы следующим образом: Настроить алгоритм 

программирования, как указано на рисунке 7.3.2.3 

 
Рисунок 7.3.2.3 
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И запустить загрузку (нажать клавишу F8 или в меню Flash->Download ). Из настроек на 

вкладке Flash Download видно, что очистка и запись памяти не происходит. 

После выполнения загрузчиком перекачки программы в ОЗУ, Keil выполнит сравнение 

скомпилированной программы и программы в ОЗУ, что подтвердит её целостность. 

 

Remap – использование своего загрузчика. В PACK присутствует алгоритм 

загрузчика для двух AM29LV160DB32. Данный алгоритм имеет префикс REMAP. 

Ограничение исполняемой программы  - 4кбайта. 

 

Примечание: исходные данные всех алгоритмов содержатся в папке Flash PACK-файла. 
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8. Загрузка программы по UART  

Для загрузки по UART из среды Keil используется приложение bootstrap. (оно содержится 

в папке PACK по адресу ..\boot\bootstrap.exe (для удобства использования, можно 

скопировать bootstrap.exe в папку с проектом) 

 

Для его выбора, необходимо произвести настройки, представленные на рисунке 8.1: 

 

 
Рисунок 8.1 

На вкладке Utilities выбрать «Use External Tool for Flash Programming» 

 

В строке Command указать ссылку на bootstrap.exe (можно использовать относительные 

пути). В примере, данное приложение лежит в папке с проектом. 

 

В строке «Arguments» необходимо указать 4 аргумента через пробел: 

1. Номер порта. В примере это Com5. Первым аргументом идет его номер 5. 

2. Скорость загрузки по UART. Микроконтроллер автоматически настраивает 

скорость, используя внутренний таймер TIM1. 

3. Ссылка на hex файл прошивки. В данном случае, он лежит в папке с проектом. 

4. Адрес памяти, начиная с которого, будет располагаться программа. Он же 

является адресом, куда будет передано управление после загрузки (окончания 

работы bootloader-а). Адрес должен совпадать с адресом, указанным в 

линковщике. 

Для индикации работы bootstrap, необходимо установить галочку «Run Independent» 

 

Для получения hex файла с необходимым форматированием для bootstrap, необходимо 

добавить инструкцию 
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«путь»\Keil\ARM\ARMCC\bin\fromelf.exe #L --vhx --8x1 –output firstProject.hex 

 

 
Рисунок 8.2 

Линковщик необходимо настроить для исполнения программы в ОЗУ. Начальный адрес 

программы 0x8000000, размер 0x40000 (256кбайт). 

 
Рисунок 8.3 

После сохранения настроек можно начать загрузку программы 
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Рисунок 8.4 

При использовании USB-TTL преобразователя PL2303 или аналогов, bootstrap перед 

загрузкой программы, генерирует импульс по линии DTR#, что позволяет ее использовать 

в качестве сброса микроконтроллера на отладочной плате. 
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9. Примеры готовых проектов 

 
Рисунок 9.1.1 

При нажатии на кнопку «Pack Installer», появится окно 

 
Рисунок 9.1.2 

В данном окне, если в левой части, среди «Devices», выбрать интересующий контроллер,  

а в правой открыть вкладку Examples, то появится список готовых проверенных проектов 

по каждой библиотеке, а также 3 режима загрузки базовой программы Blink. 
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При нажатии кнопки «Copy», среда Keil запрашивает указать папку, в которой будет 

размещен проект. 

 

 
Рисунок 9.1.3 

После нажатия кнопки «ОК», готовый базовый проект скопируется в указанную папу и 

откроется в среде Keil. 

Примечание: базовые проекты Blink рассчитаны на 3 режима загрузки (в ОЗУ, по UART, 

во внешнюю ПЗУ), все остальные - настроены на работу в ОЗУ. 
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10.   Периферия. 

В среде Keil имеется возможность работы с периферией. Для среды Keil v5 и выше, все 

настройки уже произведены при распаковке PACK-файла.  

Если вы используете Keil v4, то необходимо в настройках проекта вручную подключить 

*.SVD файл. 

 
Рисунок 10.1 

В режиме отладки можно выбрать Peripherals->System Viewer, затем интересующий 

интерфейс и номер интерфейса. 
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Рисунок 10.2 

Справа появится окно с регистрами, которые относятся к данному интерфейсу и их 

состояние в данный момент паузы программы. 

 
Рисунок 10.3 


